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About this document 

Scope and purpose  

This user guide provides an overview of the evaluation board EVAL-M1-IM06B50 including its key features, data, 
pin assignments and mechanical dimensions.  

The EVAL-M1-IM06B50 is an evaluation board for motor drive applications, as part of the iMOTIONTM modular 

application design kit. In combination with the control board equipped with the M1 20-pin interface connector 

such as EVAL-M1-101T, it features and demonstrates Infineon’s CIPOS™ Mini IPM technology and advanced 
motion control engine (MCE 2.0) technology for permanent magnet motors drive. 

The IM06B50GC1 CIPOS™ Mini IPM has 600 V of voltage and 50 A of current rating. It is optimized for major home 

appliances like air conditioners, pumps, fans and other low & middle power motor drive applications. 

This evaluation board EVAL-M1-IM06B50 is developed to support customers during their first steps designing 

applications with CIPOS™ Mini IPM IM06B50GC1 and running any permanent magnet motor via senseless 
sinusoidal control. 

Intended audience 

This user guide is intended for all technical specialists who know motor control, middle- and low-power 

electronics converters. The board is intended to be used under laboratory conditions. 

Evaluation Board 

This board will be used during design-in, for evaluation and measurement of characteristics, and proof of data 
sheet specifications.  

Note: PCB and auxiliary circuits are NOT optimized for final customer design. 
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 

(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

 
Environmental conditions have been considered in the design of the Evaluation Boards and Reference 
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 
has been tested by Infineon Technologies only as described in this document. The design is not qualified 

in terms of safety requirements, manufacturing and operation over the entire operating temperature 

range or lifetime. 
 
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 

same procedures as regular products regarding returned material analysis (RMA), process change 
notification (PCN) and product discontinuation (PD). 
 

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 
requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant 

requirements and standards of the country in which they are operated. 
 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 

addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 

managed according to the terms and conditions set forth in this document and in other related 

documentation supplied with the respective Evaluation Board or Reference Board.  
 
It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 

and correctness of the information provided in this document with respect to such application. 

 
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 
cause any harm to persons or third party property.  

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or 
for merchantability.  

 
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 
Boards and Reference Boards and/or from any information provided in this document. The customer is 

obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or 
damages arising out of or resulting from any use thereof. 

 
Infineon Technologies reserves the right to modify this document and/or any information provided 
herein at any time without further notice. 
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Safety precautions 

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

 

Warning: The DC link potential of this board is up to 400 VDC. When measuring voltage 
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do 

so may result in personal injury or death. 

 

Warning: The evaluation board contains DC bus capacitors which take time to 
discharge after removal of the main supply. Before working on the drive system, wait 
five minutes for capacitors to discharge to safe voltage levels. Failure to do so may 

result in personal injury or death. Darkened display LEDs are not an indication that 

capacitors have discharged to safe voltage levels. 

 

Warning: The evaluation board is connected to the grid input during testing. Hence, 
high-voltage differential probes must be used when measuring voltage waveforms by 

oscilloscope. Failure to do so may result in personal injury or death. Darkened display 

LEDs are not an indication that capacitors have discharged to safe voltage levels. 

 

Warning: Remove or disconnect power from the drive before you disconnect or 
reconnect wires, or perform maintenance work. Wait five minutes after removing 

power to discharge the bus capacitors. Do not attempt to service the drive until the bus 
capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

 

Caution: The heat sink and device surfaces of the evaluation or reference board may 

become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

 

Caution: Only personnel familiar with the drive, power electronics and associated 
machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

 

Caution: The evaluation board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 
installing, testing, servicing or repairing the assembly. Component damage may result 

if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 

motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

 

Caution: The evaluation board is shipped with packing materials that need to be 
removed prior to installation. Failure to remove all packing materials that are 
unnecessary for system installation may result in overheating or abnormal operating 

conditions. 
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1 The board at a glance 

The EVAL-M1-IM06B50 evaluation power board is a part of the iMOTIONTM modular application design kit for 

motor drives (iMOTIONTM MADK). The MADK platform is intended for use with various power stages and 
different control boards. The EVAL-M1-IM06B50 can easily be interfaced through the 20-pin iMOTIONTM MADK 
M1 connector such as EVAL-M1-101T and is intended for single-motor control only. 

The EVAL-M1-IM06B50 evaluation board is available through regular Infineon distribution partners as well as on 
Infineon's website. The features of this board are described in the main features chapter of this document, 
whereas the remaining paragraphs provide information to enable the customers to copy, modify and qualify 

the design for production according to their own specific requirements.  

Environmental conditions were considered in the design of the EVAL-M1-IM06B50, but the board is not qualified 

in terms of safety requirements or manufacturing and operation over the entire operating temperature range 
or lifetime. The boards provided by Infineon are subject to functional testing only. 

The evaluation boards are not subject to the same procedures as regular products regarding returned material 
analysis (RMA), process change notification (PCN) and product discontinuation (PD). Evaluation boards are 
intended to be used under laboratory conditions by technical specialists only. 

1.1 Delivery content 

The EVAL-M1-IM06B50 evaluation board is designed to provide an easy-to-use power stage based on the 
Infineon's CIPOS™ Mini intelligent power module (IM06B50GC1 IPM).  

The delivery includes the finished board as shown in Figure 1 and Figure 2. It provides a single-phase AC 
connector, an EMI filter and soft power-up circuit, input rectifier, DC bus capacitors and 3-phase output for 

connecting the motor.  

It also contains CoolSETTM based auxiliary power supply to provide 15 V & 5 V, emitter shunts for current sensing 

and overcurrent protection, and a voltage divider for DC-link voltage measurement. The board shown here can 

be operated directly with the required power supply without the need for additional components. 

1.2 Block diagram 

The block diagram of the EVAL-M1-IM06B50 is depicted in Figure 1.  
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Figure 1 Block diagram of the EVAL-M1-IM06B50 
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Figure 2 points out the functional groups on the top side of the EVAL-M1-IM06B50 design: 
 

 
 

 

 

 

 

 

 

 

 

Figure 2 Functional groups of the EVAL-M1-IM06B50 reference design 

 

 

 

1. 220 VAC & PE input connector 
2. EMI filter  

3. In-rush relay control 

4. DC bus capacitors  
5. Connector for DC bus  

(For external PFC or DC source) 

6. UVW motor phase connector 
7. Auxiliary power supply  
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8.  iMOTIONTM MADK M1 connector (20-pin) 
9.  Current sensing OPA (SGM721XN5) 

10. OCP & OCT comparator (LM393) 

11. DCDC for cooling fan 

12. BLDC cooling fan  

13. Heat sink  

(IM06B50 + input rectifier + shunt resistor) 

 

 

11 



  

 7 of 47 V1.0  

  2025-07-31 

EVAL-M1-IM06B50 user guide 
iMOTION™ modular application design kit 

The board at a glance 

  

1.3 Main features 

The EVAL-M1-IM06B50 is an evaluation board for motor drive applications. Combined in a kit with one of the 
available MADK control board options, it demonstrates Infineon’s motion control IC and IPM technology for 

motor drives. 

The evaluation board characteristics include: 

• Input voltage 85~265 VAC 

• Maximum 20 A input and output current 

• Maximum 3000 W motor power output 

• On board EMI filter 

• Current sensing operational amplifier (OPA) with single shunt 

• Auxiliary power supply with 15 V, 5 V 

• Overcurrent hardware protection & over temperature protection 

• Sensing of DC-link voltage 

• Thermistor output 

• PCB is 166 mm × 166 mm, two layers with 2 oz. copper 

• RoHS compliant 

1.4 Board parameters and technical data 

Table 2 depicts the important specifications of the evaluation board EVAL-M1-IM06B50. 

Table 2 EVAL-M1-IM06B50 board specifications 

Parameter Symbol Conditions / comments Value Unit 

Input voltage Vac Optimized design for 220 VAC application  

Lower AC input, less motor power output 

85 ~ 265 Vrms 

Maximum input current  Iac(max) Input 220 VAC, Ta=25C 20 Arms 

Maximum input power Pin(max) Input 220 VAC, fPWM = 6 kHz, Ta=25°C, Tcase= 105°C 

Force cooling mode 

3000 W 

Maximum motor current  Imtr(max) Input 220 VAC, fPWM=5 kHz, Ta=25°C, Tcase= 105°C  

Force cooling mode 

30 Arms 

Maximum DC bus 

voltage 

Vdc(max) DC bus capacitors are 400 V, 820µFX4   

(or 1000µF X4) 

400 V 

Minimum DC bus voltage Vdc(min) Aux power supply brown-in voltage 80 V 

Shunt Resistance Rsh Two 5 mΩ in parallel, with external OPA gain 10 2.5 mΩ 

Protections 

Motor current protection 

trigger level 11 

Itrip Comparator source for OC trigger level, related 

to iMOTIONTM internal comparator setup 

Configured 
in 
iMOTIONTM 

Apeak 

 
1     For iMOTIONTM IC IMCxxx, there are three types of current protection setup: Gatekill-pin, Comparator and Both.  If you select 

“comparator” mode, the external Gatekill-pin signal will be not used, and the signal ISS will be compared by the internal comparator 

with the “Overcurrent comparator current trip level (peak)” value set in iMOTIONTM Solution Designer, it should be based on motor 

rated current to protect motor. 
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Parameter Symbol Conditions / comments Value Unit 

Solution 

Designer 

Motor current protection 

trigger level 2 

Itrip Gatekill-pin input source overcurrent 

protection, related to hardware setup 

59 Apeak 

Thermal protection level Tprotection Temperature gap between junction and NTC 
(negative temperature coefficient) sensor needs 
to be considered;  recommended is  a setting of 

105°C or less 

105 °C 

 

Auxiliary power supply 1 – 15 V 

Output voltage Vout1 Used for IPM and cooling fan 15 ± 5% V 

Maximum output current Iout1  450 mA 

 

Auxiliary power supply 2 – 5 V 

Output voltage Vout2 Used for IMC controller and protection circuits 5 ± 1% V 

Maximum output current Iout2  150 mA 

 

PCB characteristics 

Dimension  Length × width × height 166×166×62 mm 

Material  FR4, 1.6 mm thickness, 2oz  PCB   

 

System environment 

Ambient temperature Ta Non-condensing, maximum RH of 95% 0 ~ 50 °C 
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2 System and functional description 

2.1 Getting started with EVAL-M1-IM06B50 

In order to run the motor system, a combination of the iMOTIONTM MADK power board (EVAL-M1-IM06B50) and 
the matching MADK control board (EVAL-M1-101T or other control board) are required. This chapter provides 
more details on setting up the system and getting start with the iMOTIONTM MADK development platform. 

Note: If you are using an EVAL-M1-101T control board, please make the following changes to better 

match EVAL-M1-IM06B50 for op-amp current sensing, since EVAL-M1-101T’s default 
configuration is directly ADC sample. 

1. Remove R6 of EVAL-M1-101T  (Since EVAL-M1-IM06B50 uses external OPA circuit, it has its own bias) 

2. Change R7 of EVAL-M1-101T from 2 kΩ change to 0 ohm  (To reduce total R & C delay for current sensing path) 

 

The EVAL-M1-IM06B50 reference designs are tested with EVAL-M1-101T controller boards.  

The following steps have to do to achieve a usable motor controller IC from a blank IMC101T: 

• Programming of the motion control engine (MCE) and parameter sets for system and motor. 

• Programming of customer scripts (optional). 

The iMOTIONTM software tool, iMOTIONTM Solution Desinger, is required to initially set up the system, as well as 
to control and fine-tune the system performance to match the user’s exact needs. this tool is available for 

download via below Infineon website link. Please visit this page periodically to check for updates. 

• iMOTION Solution Designer 

 

Figure 3 iMOTION™ Solution Designer  

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.imotionsolutiondesigner
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Figure 4 Sdpack installation  

After installed iMOTIONTM Solution Designer, need to install Sdpack by “Open->Package Management”. Select 
necessary version from left available list and click “Install”. 

iMOTIONTM Link or on board debugger is needed to bridge the PC/debugger side and motor drive system (the 

target iMOTIONTM device, hot side) with 1 kV DC galvanic isolation.  

This chapter provides more details on setting up the system and getting start with the iMOTIONTM development 

platform. 

After downloading and installing the iMOTIONTM PC tool, iMOTIONTM Solution Designer, the following steps need 

to be taken to run the motor. Refer to documentation iMOTION™ Solution Designer and Getting Started with 
iMOTION Solution Designer for more information. 

Figure 5 shows the basic system connection using EVAL-M1-IM06B50 to run a 5KW GK6081-6AC31 motor with 
iMOTIONTM Solution Designer. 

https://www.infineon.com/assets/row/public/documents/60/44/infineon-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/68/infineon-imotion-solution-designer-gettingstarted-en.pdf
https://www.infineon.com/assets/row/public/documents/60/68/infineon-imotion-solution-designer-gettingstarted-en.pdf
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Figure 5 System connection example  

Here are the steps needed to run the motor: 

1. Connect EVAL-M1-101T control board to EVAL-M1-IM06B50  

2. Connect PC-USB connector to EVAL-M1-101T J1 by iMOTIONTM Link or X101 by pure USB cable. 

a. If iMOTIONTM Link is used, please remove R110 and R111 on EVAL-M1-101T: 

b. If pure USB cable is used with on board debugger, please mount R110 and R111. 

3. Connect 220 V AC power supply and UVW outputs to the motor. 

4. Open iMOTIONTM Solution Designer as shown in Figure 3, crease new project by “New project -> Create New 

Project” as shown in Figure 6. 

a. Select available sdpack version: 

b. Create file name: 

c. Select save location: 

d. Create project name: 

e. Check box “Create self-contained project”. 

To EVAL-M1-101T 

(controller board) 

AC 

Power 
Input 

 

Motor phase 
outputs 
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Figure 6 Create iMOTIONTM Solution Designer project 

5. Select iMOTIONTM device matched EVAL-M1-101T, here is IMC101T-T038. 

 

Figure 7 Select iMOTIONTM device 



  

 13 of 47 V1.0  

  2025-07-31 

EVAL-M1-IM06B50 user guide 
iMOTION™ modular application design kit 

System and functional description 

  

6. Configure parameters in Config Wizard. Please open “Expert mode” by clicking right up icon . 

a. For “IC configuration”, the default parameters are ok for this evaluation board. 

 

Figure 8 IC configuration 

b. For “User Pin Configuration”, the default parameters are ok for basic motor running. These 

configurations can achieve more further pin functions evaluation. 

 

Figure 9 User Pin Configuration 
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c. For “Input Supply”, 5V DC should be configured as control supply voltage of this evaluation board. 

 

Figure 10 Input Supply 

d. For “DC Bus Sensing Feedback”, lower resistor is 13.3 Khom and upper resistor is 1360 Khom, please 

refer to schematic of EVAL-M1-101T and EVAL-M1-IM06B50 for more information. 

 

Figure 11 DC Bus Sensing Feedback 

e. For “Inverter”, please refer to IM06B50GC1 datasheet and board parameters and technical data section 
1.4 of this evaluation board to configure parameters here. The configured parameters as shown in 
Figure 12. Please note that the maximum motor current of this evaluation board is 30 Arms. So here 
configured “Rated Inverter output current” to 30 Arms. 

https://www.infineon.com/assets/row/public/documents/60/49/infineon-im06b50gc1-datasheet-en.pdf
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Figure 12 Inverter 

f. For “Motor Current Sensing Feedback”, please refer to Section 2.2.3 of this document for detail 
calculation. Please configure all parameters as shown in Figure 13, all parameters here matched this 

evaluation board. 

 

Figure 13 Motor Current Sensing Feedback 

g. For “Motor”, please configure them based on actual motor used. Regarding how to measure motor 
parameters, please refer to document Basic Motor Parameters and the Configuration. 

https://www.infineon.com/assets/row/public/documents/60/42/infineon-basic-motor-parameters-and-the-configuration-applicationnotes-en.pdf
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Figure 14 Motor 

h. For “Load”, please configure them based on actual load used. They are related to “Rated power”, 
“Minimum speed”, “Maximum speed”.  Please click question mark right input box for detail 

information. 

 

Figure 15 Load 

i. For “Motor Control Configuration”, PWM frequency can be configured to evaluate performance of 
this IPM module. Meanwhile, “Current control update rate scale” and “Speed control update rate 

scale” can be configured to improve CPU load.  Please click question mark right input box for detail 
information. 

Regarding “Rotor angle feedback selection” and “Motor control mode” please refer to Functional 
Reference Manual iMOTION™ Motion Control Engine for more information. 

https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
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Figure 16 Motor Control Configuration 

j. For “Control Regulators”, velocity regulator and current regulator should be tuned at here. These 
parameters should be turned according to actual motor running performance. For general 

evaluation IPM and Filed Control is not need, please leave them as default value. 

 

Figure 17 Control Regulators 

k. For “FOC and inverter”, they are for high performance motor running, for general evaluation, please 
leave them as default value. 
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Figure 18 FOC and inverter 

l. For “Application”, it configures motor start-up performance. There are three start-up method: park + 
open loop ramp, initial angel sensing, and direct start. Please refer to Functional Reference Manual 

iMOTION™ Motion Control Engine for more information. The general start-up method is park + open 
loop.  For this method, “Open loop ramp rate”, “Parking time”, “Low speed limit”, “Low speed 

threshold” and “Speed control ramp rate limit” are the key parameters for start-up performance. 

 

Figure 19 Application 

m. For “Application”, it configures motor start-up performance. There are three start-up method: park + 
open loop ramp, initial angel sensing, and direct start. Please refer to Functional Reference Manual 

iMOTIONTM Motion Control Engine for more information. The general start-up method is park + open 

loop.  For this method, “Open loop ramp rate”, “Parking time”, “Low speed limit”, “Low speed 
threshold” and “Speed control ramp rate limit” are the key parameters for start-up performance. 

https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
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Figure 20 Application 

n. For “Angle Feedback”, generally only “Flux estimator time constant” needs to be configured. If Flux 
PLL is configured as rotor angle feedback, then “Flux estimator time constant” is very important for 

flux angle estimation. The recommended flux estimator time constant is between 4 and 5 times the 

motor winding time constant (L/R). Generally, “Flux PLL compensator proportional gain” and “Flux 

PLL compensator integral gain are left to default value.” 

 

Figure 21 Application 

o. For “Motor protection”, please enabled all protection items to protect evaluation system well.  

• Over current protection has two sources: Gate kill pin and internal comparison. Here two 

sources are selected. The threshold of Gate kill pin is designed by hardware of evaluation board, 
please refer to schematic for more detail information. The threshold of internal comparison is 
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configured by “Overcurrent comparator current trip level (peak)”. Recommend configuring 
“Overcurrent comparator current trip level (peak)” only a little bigger than motor rated current 

to protect motor avoid damage. 

• Voltage protection please configure them as shown in Figure 22.  

• Please refer section 4.5 of this document for “NTC voltage threshold for an over-tempture fault” 
configuration. 

• All other configurations please use value shown in Figure 22. 

 

 

Figure 22 Motor Protection 

p. For “System Protection”, the default configuration is well. 
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Figure 23 System Protection 

7. After parameters configuration in Config Wizard, please click menu “Project->Build Project” enter build 

window to build project to generate parameters file and script file (optional). 

 

Figure 24 Build Project 

8. Power on 220 V AC. 

9. Click menu “Tools -> Programmer-> Connect”, select available COM port to connect EVAL-M1-101T. 

Notes: if you encounter connection issue after clicking “Connect” button, please power off EVAL-M1-101T first, then click 

“Connect” button in Figure 26 and power on EVAL-M1-101 in 2~10 seconds. Please try again if fails. 
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Figure 25 Connect target board 

10. Click button “Program” to download parameter and firmware. Script code will also be downloaded if it was 
selected in build project window. 

  

Figure 26 Programming 
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11. Close programming window in Figure 26. Click “Tools -> Dashboard” and click “no” on popup window 
“Download Parameter to target before switching to Dashboard” to enter dashboard window. Then you can 

change “Target speed” and click “Start Motor” to run a motor for evaluation test. 

 

Figure 27 Dashboard 
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2.2 Description of the functional blocks 

The motor inverter of EVAL-M1-IM06B50 reference design is implemented by the IM06B50 module, and the 
auxiliary power supply is based on fixed frequency CoolSETTM ICE5AR4770BZS.  

Motor current sensing is single shunt mode, with an external OPA SGM721XN5 for 10 X gain. 

2.2.1 Overview of IM06B50GC1 

Figure 28 illustrates the internal block diagram of the CIPOS™ Mini IPM IM06B50GC1.  

Main features include: 

• 3 half bridges with TRENCHSTOPTM  50 A / 600 V and antiparallel diodes for inverter section 

• Very low thermal resistance due to DCB 

• Rugged SOI gate driver technology with stability against transient and negative voltage 

• Negative potential allowed up to VS = -11 V for single transmission at VBS = 15 V 

• Integrated bootstrap functionality 

• Overcurrent shutdown, and build-in temperature monitor 

• Undervoltage lockout and all six switches turn off during protection 

• Low-side emitter pins accessible for phase current monitoring (open emitter) 

• Cross conduction prevention and sleep function 
 

 

Figure 28 IM06B50GC1 internal block 
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2.2.2 Overview of ICE5AR4770BZS   

The ICE5AR4770BZS is Infineon’s latest 5th generation fixed frequency CoolSETTM, offers high performance and 
integration of latest generation of 700 V CoolMOSTM super junction MOSFETs in DIP-7 package.  

Figure 29 illustrates the internal block diagram and typical isolated flyback application. 

 

Figure 29 ICE5AR4770BZS internal block and typical application in isolated flyback mode 

Main features of ICE5AR4770BZS include: 

• 100 kHz maximum switching frequency with 700 V integrated MOSFET 
• Power delivery of up to 15 W with universal wide input range (85~300 VAC) DCM design 

• Brown-in protection, fast and robust start-up operation with cascode configuration 

• 3-level selectable entry/exit active-burst mode profile (optional) 

• Built-in digital soft start 
• Cycle by cycle peak current limitation 
• Support both DCM and CCM operation with slope compensation 

• Integrated error amplifier to support direct feedback typical with non-isolated flyback topology 

• Digital frequency reduction with decreasing load for higher efficiency 
• Frequency jitter and soft gate driving for low EMI 
• Limited charging current for VCC pin short to ground 

• Comprehensive protection with VCC over voltage, VCC undervoltage, overload/open loop, over-temperature 

protection 
• Auto-restart for all protection features 
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2.2.3 Motor current sensing op-amp configuration and calculation  

To suppress common mode noise between this power board and the MADK control board, an 11 MHz rail-to rail 
I/O CMOS OPA SGM721XN5 is used for motor current sensing.  

Two 5 mΩ 2.5 W (2512 package) shunt resistor and 10X external-gain OPA is the default configuration for the 
EVAL-M1-IM06B50 evaluation design, which means 1 A motor current produces 25 mV voltage to ADC input, the 

“Motor feedback circuit current gain” in iMOTIONTM Solution Designer Config Wizard needs to input of 25 mV/A. 

 

Figure 30 Motor Current Sensing configuration in iMOTIONTM Solution Designer  

 

Figure 31 Current feedback with external 10X op-amp 

Figure 31 shows the external amplifier gain circuit in EVAL-M1-IM06B50 evaluation design, which is a typical 
differential amplifier based on SGM721XN5, with input low-pass filter (LPF) and operational bias. C29, R28, R29, 

R30 and R31 build the input differential mode LPF, which can damp parts of PWM switching noise. The default 

LPF time constants is 2*RC = 2*(R28//R29) *C29 = 470 ns. The typical setup time is 0.1~0.5 µs, which depends on 
PCB layout, DC bus decouples capacitor and IGBT / MOS gate driver configuration. 

For better common-mode noise-rejection ability, a balanced differential amplifier is highly recommended, 
which means R33 is equal to the value of R26 & R27 in parallel.  
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The divider of R26 & R27 provide operational bias for the amplifier, which affects the maximum motoring 
current and regeneration current range. With the default configuration of EVAL-M1-IM06B50, R26=22 k & 

R27=220 k, the op-amp operational bias is 5000 mV * 22 / (22+220) = 454 mV, which means: 

- Op-amp outputs 454 mV at zero motor current (motor stopped), 454 mV/op-amp gain/RS1 is the maximum 
allowable regeneration current.  

- If 1X ADC internal gain is selected, 4546 mV range for motor current sensing (5000 mV – 454 mV = 4546 mV). 
And 4546 mV/op-amp gain/RS1 is the maximum allowable motor current. “Motor Rated Amps * Motoring 

Current Limit” should be below this maximum allowable range. 

- If 3X ADC internal gain is selected, 1212 mV range for motor current sensing (5000/3 – 454 mV = 1666 - 454 
mV = 1212 mV). And “1212 mV/op-amp gain/RS1” is the maximum allowable motor current. “Motor Rated 
Amps * Motoring Current Limit” should be below this maximum allowable range. 

- For applications that never work at regeneration mode (e.g. air conditioner), the OPA output bias wastes 

the available range of ADC and reduces the available ADC range. 

- For applications that need more current range for regeneration (e.g. fan application), the amplifier bias 
needs an increase based on the regeneration requirement. For example, R26 = R27 = 2 * R33 for a bias of 

2.5 V (50% of AD range) so that they have the same range for motoring current and regeneration current. 

 

Please note that EVAL-M1-101T default configuration is in direct current sensing mode, R6 & R7 on EVAL-M1-
101T are not needed for EVAL-M1-IM06B50’s motor current sensing. We need to remove R6, and short R7 on 

EVAL-M1-101T control board, as shown in Figure 32. 
 

 

Figure 32 Modification on EVAL-M1-101T (remove R6 and short R7) 

 

 

 



  

 28 of 47 V1.0  

  2025-07-31 

EVAL-M1-IM06B50 user guide 
iMOTION™ modular application design kit 

System design 

  

3 System design 

The EVAL-M1-IM06B50 board is an optimized design for 220 V major home appliances like air conditioners 
applications. To meet individual customer requirements and to make the EVAL-M1-IM06B50 reference design a 
basis for development or modification, all board design data such as schematics, Gerber and Altium design 

data can be found on the Infineon homepage. 

 

3.1 Schematics 

The overall schematic diagram for EVAL-M1-IM06B50 is provided in Figure 33 and Figure 34. 

 

Figure 33 Aux power supply for EVAL-M1-IM06B50 

Figure 33 shows the 8 W isolated flyback power supply based on ICE5AR4770BZS, +15 V and +5 V output for IPM 
and controller board, the major function information are listed as below: 

- Transformer T1 is based on EE16 core, and the rated power is 8 W, which is suitable for most air 

conditioner applications. 

- R3, R5, R7 and R8 decide the brown-in and brown-out voltage for power-on and power-off, which means 

ICE5AR4770BZS start work when DC bus voltage is over 82 V and stop work when DC bus below 40 V. 

- R10 and R11 sensing the maximal peak current, related to cycle-by cycle current limitation. 

- R15, R16 and R18 decide the output voltage for +15 V and +7 V. 

- U5 is the DC-DC controller for cooling fan speed, R19, R23 and R21 can be adjusted to tune initial fan speed 

and adjustment based on IPM temperature.  VR1 is reserved for manual fan speed adjustment (by 

removing R20).  

- 12 V power supply for relay control is from +15 V via D1 and D2, which is not very accurate. 
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- PC817 used for primary isolation of flyback power supply, is not for real isolation, but for easier PCB layout 
for signal ground and power ground connections. This can reduce common-mode noise for controller 

board and achieve higher SNR for motor current sensing. 

Figure 34 shows the invertor section of EVAL-M1-IM06B50, which contains IM06B50GC1 and its peripheral 
circuits, the major function information is listed below: 

- U6 (SGM721) is a typical balanced difference amplifier for 10 X gain, the OPA bias decided by divider of R26 
& R27; C29, C27 and C31 effect the total LPF bandwidth.  

- U7A (LM393) for overcurrent protection; R50 is the major resistor for overcurrent threshold adjustment.  

- U7B (LM393) for over-temperature protection; the pull-up resistor for IPM internal NTC is not a unique 
device, which is a combination of R55, R56, D10 and circuit in “Gatekill” and “IPM_TEMP” networks on 

control board, it is not recommended to change the hardware setup of U7B. 

- J5 is reserved for Vdc bus voltage test or applications that use external DC source or PFC circuits. 

- C54 ~ C57 are DC bus capacitors; default value is 400 V, 820 µF or 1000 µF. Please replace them by 450 V 

capacitors if there are external 380 V PFC or over 265 VAC   inputs.  

- L5 is common-mode choker, which is the key component for EMI performance. Two packages placed on 

the PCB for convenient EMI performance testing and evaluation, suitable for 3 ~ 9 mH and 18~23 A 
common mode inductor. 

- J2 is 20-pin interface for MADK control boards; only pin 10 & pin 12 (IU+ & IU-) are used for single-shunt 

current sensing (ISS from OPA output).  
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Figure 34 Schematics for IM06B50 IPM and peripheral circuit 
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3.2 Layout 

This board has two electrical layers with 70 µm copper (2 oz. copper) and dimensions of 166 mm × 166 mm.  
The thickness of the PCB board is 1.6 mm. Figure 35  illustrates the top assembly print of the reference design. 
 

 

Figure 35 Top assembly print of the EVAL-M1-IM06B50 reference design  
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The top layer and bottom layer routing of the PCB are provided in Figure 36  and Figure 37. 

 

Figure 36 Top layer routing of the EVAL-M1-IM06B50 

 

 

Figure 37 Bottom layer routing of the EVAL-M1-IM06B50 
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3.3 Bill of material  

Table 3 shows the major parts of EVAL-M1-IM06B50 design.  

The complete bill of material is available on the download section of the Infineon homepage. A log-in is 
required to download this material.  

Table 3 BOM of the most important/critical parts of the evaluation or reference board 

S. No. 
Ref 

Designator 
Description Manufacturer Manufacturer P/N 

U6 SGM721XN5 11MHz, 8.5V/µS, Rail-to-Rail OPA SG Micro SGM721XN5/TR 

U7 LM393 Dual comparator     

Q1 IRLML2030 30V 154mOhm@4.5V MOSFET 
Infineon 

Technologies IRLML2030 

U8 IM06B50GC1 CIPOSTM MINI 

Infineon 

Technologies IM06B50GC1 

U5 IFX91041EJV 

1.8A DC/DC Step-Down Voltage 

Regulator, Adjustable  

Infineon 

Technologies IFX91041EJV 

U1 ICE5AR4770  Fixed Frequency 700 V CoolSETTM 
Infineon 

Technologies ICE5AR4770BZS DIP-7 

RL1 G4A-1A-PE 20A Relay   

FAN FAN4028 

FAN4028 12V 3.36W, 14500rpm, 

19.1CFM;  SANYO 9GA0412P3H01 

BR1 D25XB60 25A 600V Diode Bridge   

C54~C57 820uF, 400V 

Diameter 35mm,  

Height 45mm~60mm,  

820uF~1000uF, 400V 

Wurth 

Elektronik 861021386035 

T1 710uH/EE16 

Wurth Electronics Midcom 
(750343739), Core: 150-2182 
(EE16/8/5), bobbin: 070-5280 (9-pin 

EXT, THT, horizontal version) 

Wurth 

Electronics 750343739 

R24, R25 680k 1206 Thick Film Chip Resistor   

L1, L2, L3 650R 
WE-CBF SMD EMI Suppression 

Ferrite Bead 

Wurth 

Elektronik INDC3216X130N 

C50 470nF / 630V CBB22 Film Capacitors   

F1 30A 250VAC 30A 250VAC fuse   

C34, C41 5.6nF, 275V 
Film Capacitor, THT, L13W5H10, 

5.6nF, 275V 

Wurth 

Elektronik 890324023002CS 

RS1, RS2 5mR Current Sense Precision Resistor Isabellenhuette BVT-I-R005 

L5 3mH 
WE-CMBNC Common Mode Power 

Line Choke, Type XL, 3mH, 23A, 250V 

Wurth 

Elektronik 7448052303 

C35, C40 1uF, 275V 
WCAP-FTX2 Film Capacitor, THT, 

L26W11H20, 1uF, 275V 

Wurth 

Elektronik 890324026027CS 
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3.4  Connector details 

General information about the connectors of the EVAL-M1-IM06B50 reference design is provided in this section.  
Table 4 includes the details of the AC input connector. 

Table 4 AC input connector (J4) 

PIN Label Function 

1 L AC line 

2 N AC neutral 

3 PE Protection earth 

 

Table 5 provides the details of the motor UVW output connector J3. 

Table 5 Motor side connector (J3) 

PIN Label Function 

1 U Connected to motor phase U 

2 V Connected to motor phase V 

3 W Connected to motor phase W 
 

 

Table 6 provides the details of the DC bus output connector J5, for external PFC or DC source connection. 

Table 6 DC bus connector (J5) 

PIN Label Function 

1 DCP Connected to DC+  

2 GND Connected to DC-  
 

 

Table 7 provides the pin assignments of the 20-pin iMOTIONTM MADK-M1 interface connector J2. This connector 
is the interface to the controller board. 

Table 7 J2 - iMOTIONTM MADK-M1 20-pin interface connector for controller board 

Pin Name Pin name connectors 

1 PWMUH 5 V compatible logic input for high side gate driver-Phase U 

2 GND Ground 

3 PWMUL 5 V compatible logic input for low side gate driver-Phase U 

4 GND 4 GND ground 

5 PWMVH 5 V compatible logic input for high side gate driver-Phase V 

6 +5 V On board 5 V supply 

7 PWMVL 5 V compatible logic input for low side gate driver-Phase V 

8 +5 V On board 5 V supply 

9 PWMWH 5 V compatible logic input for high side gate driver-Phase W 
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Pin Name Pin name connectors 

10 I_U Positive current sense output 

11 PWMWL 5 V compatible logic input for low side gate driver-Phase W 

12 I_U- Negative current sense output or ground 

13 GK Gatekill signal – active low when overcurrent is detected 

14 DCBSense DC bus positive voltage, scaled in 0-5 V range by a voltage divider 

15 VTH Thermistor output 

16 I_V Not used 

17 I_V- Not used 

18 I_W Not used 

19 I_W- Not used 

20 VCC 15 V power supply 

 

 

3.5 Test points 

Table 8 provides the assignments of the on-board test points.  

Table 8  

Pin Name Functions & net label describe 

X1 UH High side gate driver PWM-Phase U 

X2 U Invertor output, motor phase U 

X3 UL Low side gate driver PWM-Phase U 

X4 V Invertor output, motor phase V 

X5 VH High side gate driver PWM-Phase V 

X6 VL Low side gate driver PWM-Phase V 

X7 W Inverter output, motor phase W 

X8 WH High side gate driver PWM-Phase W 

X9 WL Low side gate driver PWM-Phase W 

X10 GND Ground test point for controller board (signals ground) 

X11 ACL AC voltage measure point (L) 

X12 ACN AC voltage measure point (N) 

X13 DNI  

X14 Itrip Output of over current protection circuit (Pin 1 for LM393) 

X15 GND Power GND test point (DC-) 

X16 VTH Test point for temperature sensing (Pin 15 of IM06B50) 

X17, X18 DC+ DC+ test point 

X19 GND Ground test point for primary side of fly-back power supply  
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4 System performance* 

4.1 Heatsink thermal resistance test result 

To test the thermal impedance of heatsink to ambient RthCA, the DC source is used to conduct the IPM internal 
diodes, as shown in Figure 38. With the DC source voltage increasing, current through IPM IIPM and voltage on 
IPM VIPM are monitored by current and voltage meter, the IPM case-temperature test point is between IPM and 
heatsink, the same as Tc point of inverter IGBT of the IPM datasheet. 
 

CIPOSTM IPM  IM535-U6D 

+

-

A

V
VIPM

IIPM

     

`

PCB

Heatsink

Case temperature (Tc) test point

 

Figure 38 Heatsink thermal testing set-up  

Thermal resistance between junction to ambient RthJA is divided into 2 parts as in the following formula: thermal 

resistance between junction to case RthJC and thermal resistance between case to ambient RthCA. 

𝑅𝑡ℎ𝐽𝐴 = 𝑅𝑡ℎ𝐽𝐶 + 𝑅𝑡ℎ𝐶𝐴 

Thus, we get the following formula:  

𝑅𝑡ℎ𝐶𝐴 =
∆𝑇𝐶𝐴

𝑃𝐷.𝑡𝑜𝑡
=

𝑇𝐶 − 𝑇𝐴

𝑉𝐼𝑃𝑀  × 𝐼𝐼𝑃𝑀 
 

According to the test set-up, the test results are shown in Figure 39 below. The IPM case temperature is 
detected for about one hour until the temperature is stable. 

 

Figure 39 Heatsink thermal testing result 

*Note: All test results are used the IM535-U6D because IM60B50GC1 are almost similar IM535-U6D. 
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Therefore, the final case-to-ambient resistance value is roughly: 

𝑅𝑡ℎ𝐶𝐴 = 2.4 ℃/𝑊 

Please note that: 

• 2.4  ℃/𝑊 thermal resistance is calculated with a fan voltage of 10 V.  
• DC-DC output voltage for EVAL-M1-IM06B50’s cooling fan is 7~14.3 V in default hardware configuration, 

which is adjusted by IPM temperature from 25 ~ 125℃. 

• Cooling fan’s rate voltage is 12 V corresponding to 110℃ IPM surface temperature.  

• Tuning R19, R23 and R21 can change the relationship between fan speed (voltage) and IPM temperature. 

 

4.2 Test results for output ability 

In order to test the total output power capability of EVAL-M1-IM06B50 design, the IPM case temperature is 
tested with different MADK input power and motor output current.  

The test conditions are:  

⚫ Ambient temperature Ta=25℃ 

⚫ Cooling fan voltage is 14.3 V, 8m/s air flow after heatsink (5 mm distance center of heatsink fins) 

⚫ AC input is VAC=220 V/50 Hz (VDC bus is 290 V~310 V) 

⚫ PWM frequency 6 kHz, three-phase modulation, about 40% VDQ modulation (1000 RPM) 

 

Figure 40 shows how to monitor IPM case temperature by infrared camera from the window on PCB bottom. 

Run motor at 1000 RPM and adjust motor load until the hottest point in the center of IM06B50GC1 reaches 

105℃ (temperature rise reaches 80℃ ), get the curve for temperature rise and input power as shown in Figure 

41.  
 

 

Figure 40 Infrared camera image for IPM temperature test 
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Figure 41 EVAL-M1-IM06B50 output power capability test result    
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4.3 Test results for PWM range 

Figure 42 shows the output ability at different PWM frequencies, which are performed under the following 
conditions:  

⚫ 4~20 kHz PWM, three-phase modulation  

⚫ Run GK6081 motor at 1000RPM (about 40% VDQ modulation) and increase motor load at given PWM 

frequency, till the hottest case temperature of IM06B50GC1 reaches 105℃ 

⚫ Ambient temperature Ta=25℃ 

⚫ Cooling fan voltage is 14.3 V , 8m/s air flow after heatsink (5 mm distance, center of heatsink fins) 

⚫ AC input is VAC=220 V/50 Hz (VDC bus is 290 V~310 V) 

 
 

 

Figure 42 Output ability at different PWM frequency 
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4.4 Test results for overcurrent protection 

The IM06B50GC1 product provides an overcurrent detection function by connecting the ITRIP input with the 
IGBT current feedback, and IGBT short-circuit withstand time is 5 µs. Overcurrent detection generates a 

shutdown of outputs of the gate driver if ITRIP pin input is over 525 mV and lasts longer than 300ns.  

An external LM393 comparator is used for overcurrent protection in EVAL-M1-IM06B50 design to lower the 

request of shunt resisters voltage to 90 mV, since 525 mV means too much current for 2.5 mOhm shunt 
resisters. 
 

 

Figure 43 IPM overcurrent protection and over-temperature protection circuit 

The small signal and big signal response of this overcurrent protection circuit is shown in Figure 44: 

⚫ 2.3 µs for 300 ~ 400 mV shunt resistor voltage, which means 120 ~ 160 A short-circuit condition. 

⚫ 5.9 µs for 100~150 mV shunt resistor voltage, which means 40 ~ 60 A overcurrent circuit condition. 
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Figure 44 Overcurrent protection response waveform (CH1: IFB+, CH2: VFO, CH3: Itrip) 
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4.5 Test results for over-temperature protection 

The IM06B50 IPM has an internal NTC resistor, which connects to VFO multifunction pin, as shown in Figure 45: 
 

                            

Figure 45 Temperature sensing for IM06B50GC1 

The IM06B50GC1 IPM built-in NTC thermistor is 85 kOhm at 25℃ and its B-constant is 4092, typical resistance 

and output of temperature-sensing voltage are listed in Table 9.  

Table 9 NTC – Thermistor Characteristics 

Temperature 

(℃) 

Resistance 

(kOhm) 
Vout (mV) 

50 29.972 4220 

60 20.515 4160 

70 14.315 4080 

80 10.169 4000 

90 7.345 3920 

100 5.388 3830 

110 4.009 3720 

120 3.024 3600 

125 2.639 3520 
 

Given that the VFO pin is fault-output compatible pin (LOW true at IPM fault status), the temperature sensing 

pull-up resistor needs to keep the temperature detection output as far away from the digital IO’s low level 
threshold as possible, which means the available range should be beyond 3.5 V (0.7 x VDD) to make sure IMC101T 

in EVAL-M1-101T considers this input as HIGH.  

The pull-up resistor NTC is a complex network (R55, R56, D10 and circuit in EVAL-M1-101T), the final 
temperature protection (OTP) circuit output voltage to IMC101T’s temperature-related AD input is shown in 
Figure 46. 
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Figure 46 OTP (NTC circuit) and output voltage curve   

Please note that output of VFO pin is very noisy; EVAL-M1-101T’s OTP function might be triggered by noise. 
Normally the iMOTIONTM Solution Designer setup needs to consider a margin for the input noise, for example, 

setup 3.3 ~ 3.4 V in iMOTIONTM Solution Designer corresponding to the real shutdown temperature of 110 ~ 
120°C. 

To activate over-temperature protection, 2 setups in iMOTIONTM Solution Designer are needed, as shown in 

Figure 47 :  

- Enable over temperature fault 

- Set voltage for NTC voltage threshold for an over temperature fault 
 

  

Figure 47 Over-temperature protection setup in iMOTIONTM Solution Designer 
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4.6 Test result for DC bus voltage ripple 

The EVAL-M1-IM06B50 design does not equip PFC function, which means the DC bus voltage is determined by 
the AC input voltage and the load of motor; the DC bus voltage ripple is the function of IPM inverter load and 

grid input. 

Figure 48 shows the DC bus ripple waveform with 4 x 1000µF capacitors, 220 VAC, 3000 W input power, which is 

7.5% (23.6 V / 311 V = 7.5%). 
 

 

Figure 48 Vdc ripple test at 3 kW input power 

 



  

 45 of 47 V1.0  

  2025-07-31 

EVAL-M1-IM06B50 user guide 
iMOTION™ modular application design kit 

References and appendices 

  

5 References and appendices 

5.1 Abbreviations and definitions 

Table 10 Abbreviations 

Abbreviation Meaning 

CE Conformité Européenne 

EMI Electromagnetic interference 

UL Underwriters Laboratories 

OPA Operational amplifier 

LPF Low-pass filter 

 

 

5.2 References 

[1] Datasheet of Infineon IM06B50GC1 

[2] Datasheet of Infineon IMC101T 

[3] iMOTION™ Solution Designer 

[4] Getting Started with iMOTION™ Solution Designer 

[5] Basic Motor Parameters and the Configuration 

[6]   Functional Reference Manual iMOTION™ Motion Control Engine 

 

 

5.3 Ordering details and other information  

The power board is now available for customers in small order quantities. In order to initiate the testing, 
customers are advised to order the following items: 

 

 

 

  

Base Part Number Package Standard Pack Orderable Part Number 

Form Quantity 

EVAL-M1-IM06B50  EVAL Boxed 1 EVALM1IM06B50TOBO1 

ICE5AR4770BZS DIP-7  PG-DIP-7 TUBE 2000 ICE5AR4770BZSXKLA1 

IM06B50GC1  DIP 36x21D TUBE 280 IM06B50U6DXKMA1 

https://www.infineon.com/assets/row/public/documents/60/49/infineon-im06b50gc1-datasheet-en.pdf
https://www.infineon.com/assets/row/public/documents/60/49/infineon-imc100-datasheet-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/assets/row/public/documents/60/68/infineon-imotion-solution-designer-gettingstarted-en.pdf
https://www.infineon.com/assets/row/public/documents/60/42/infineon-basic-motor-parameters-and-the-configuration-applicationnotes-en.pdf
https://www.infineon.com/assets/row/public/documents/60/44/infineon-functional-reference-manual-imotion-solution-designer-usermanual-en.pdf
https://www.infineon.com/design-resources/finder-selection-tools/evaluation-board
https://www.infineon.com/cms/en/product/power/ac-dc-power-conversion/ac-dc-integrated-power-stage-coolset/fixed-frequency-coolset/ice5ar4770bzs/
https://www.infineon.com/part/IM06B50GC1
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